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To use this help, click the left mouse button on the colored underlined text or use the tab key to 
highlight the text and press enter. Help is available on following topics: 
How to Register
Telnet to host computer
File transfer
Utilities
Edit
Printing
Session Capture
Miscellaneous Commands
Disconnecting



Terminal Emulation
 
WinTel can emulate most of the popular terminal types. Perhaps the most popular    terminal 
emulation used in the industry is VT100(ANSI). You select terminal preference either from the 
communication settings dialog box or from the settings menu. In VT100 and VT52 mode, your 
function keys F1 to F4 behave like those of DEC's PF1 to PF4. Keep the Num Lock key down to 
emulate the DEC VT100 keypad. Codes sent by numeric keypad 9 to . are same as those sent by 
DEC's VT100 terminal. Your PCs insert key sends the same code as sent by keypads enter key on
a VT100 terminal. To emulate BBSs graphic characters, choose the terminal fonts from the fonts 
menu option.

WinTel also has a raw terminal emulation mode. This allows you to view all the characters sent 
by the remote computer. These include control keys. This feature is extremely useful in 
examining    the raw codes sent by the remote computer. 

Following options in the terminal preferences may also be selected:

Local Echo
You should select this option when    when the remote computer does not echo your typed in 
characters. 
CR->CR/LF
Specifying this option enables carriage return and a line feed to be sent to the remote computer 
when you press an enter key . As most computers send you a linefeed, do not    select this option.

Buffer Lines
Here you specify the number of lines this program should save. The default is 200 lines. You 
may save upto 400 lines in the buffer for later viewing.
Terminal Width
Here you specify width of the terminal. The default is 80 columns.
Auto Wrap
Here you specify whether or not text wraps to next line when it reaches right margin. The
default setting is auto wrap as most of the BBSes assume.
Scroll Lock
Here you specify whether you want screen to scroll when the cursor is at the bottom of the screen
and gets a line feed. This is usually the case. However, some screen management programs may 
need to lock the screen becuase of the status bar. In that case enable this option.

Backspace <-> Delete
Here you specify whether you want to switch between backspace and delete keys. If you have 
selected this option then when you press the backspace key the program would send the delete 
key code and vice versa.
Terminal ID
The text in here specifies what would be sent upon terminal type negotiation when you first 
connect to the host. The default string sent for the VT100 terminal is DEC-VT100 as specified in
the RFC. However some flavors of unix host may require you to send vt100 as the terminal 



negotiation string. If that is the case then type in vt100 in the edit box.
OK
Clicking on OK will save your settings.
Cancel
Cancel will cancel all the changes you have made to the terminal prefs dialog box.



Keyboard

This command can be invoked either from Settings menu or from communication settings dialog 
box. You can examine keycode sent to the remote computer by clicking on the desired key. Here 
you can also define function keys F5 to F12 for your purposes.



Color

This command can be invoked either from the settings menu or from the communication settings
dialog box.
You can select color settings for the text and the window background by selecting color 
command from the settings menu for terminals other than VT100 (ANSI Color) terminal. For 
ANSI Color terminal, by default, light gray text is shown on the black background. Select the 
element and then choose the desired color from 16 predefined VGA colors. If these colors do not 
suit your needs then create your own colors with the help of three RGB scroll bars. By changing 
the red, green and the blue component    of a color, any desired color can be achieved. Once you 
have made your choice,    save them by clicking the OK button. You may revert back to your 
original window colors by clicking on the default button. 

Summary of Color controls:

Color Element Listbox:
Here you specify the element whose color you want to modify.
Default
When you click on this button, the window text and the background color would revert back to 
default colors of the window.
Color Boxes
You click here to choose one of the 16 colors for your background and text.
Red, Green and Blue scrollbars
These three scrollbar controls would enable you to customize your color. You change the red, 
green and blue component of a color to obtain a desired color. The color thus obtained is 
displayed in a rectangle. The RGB values are shown to the left of the scrollbars.



Fonts

You can select font command from the settings menu or from communication settings dialog 
box. A list of all the fixed size fonts are shown in listbox. A font is selected by clicking on the 
desired entry in the listbox. Font size is not shown as this program adjusts the size of the font 
based on your window size.



Default Directory

This command can be invoked either from the settings menu or from the communication settings
dialog box. Here you specify the default directory for the file transfer and your session logs. If    
the session log option is enabled then the log file would be stored in the directory you specify in 
the session log edit box. Your downloaded files from the remote system will go to the directory 
specified in the default download directory edit box.



Protocol

You select the file transfer protocol by first invoking the protocol dialog box from the settings 
menu or from the communication setting dialog box. Select the    desired protocol from the 
listbox. The default and the recommended protocol for file transfer is ZMODEM. You may    
specify maximum number of errors allowed before the 
transfer aborts. The default value is 5. You can also specify if the system should make a backup 
file in case the file you are receiving has same name as the existing file. This however does not 
apply if in the ZMODEM protocol, you have selected crash recovery option.
 
Related topics:

Description of Protocols
Receiving Files
Sending Files
ASCII Transfer options
ZMODEM options
KERMIT options



Protocol
Protocol is a set of rules which define how computers can communicate.



File Transfer and Protocols

Once you have established a connection to the remote system. You can exchange text and binary 
files. In order to transfer files, you must first select a protocol which both your system and the 
remote system recognize. A text file is a file created by a text editor known as an ASCII file. A 
binary file is a file of any kind. This could be a bitmap image or an executable file. It is 
recommended that you use binary file transfer protocol for all your file transfers. This is due to 
the fact that    ASCII file transfer protocol does not do any error checking. For binary transfers, 
you may opt for one of the protocols described below:

XMODEM/Checksum
This protocol transfers data in 128 byte packets. It does error checking of the data with 
checksum. It is reliable but is slow because of the small packet size. Also it does not have a batch
transfer capability.

XMODEM/CRC
This protocol transfers data in 128 byte packets. It does error checking of the data with 16 bit 
CRC. It is reliable but is slow because of the small packet    size. Also it does not have a batch 
transfer capability.

XMODEM (1K)
This protocol transfers data in 128 and 1024 byte packets. It is an extension of XMODEM/CRC. 
This protocol    is also known    incorrectly as YMODEM. This is not a batch protocol therefore 
only one file can be transferred per transfer.

YMODEM(BATCH)
Like XMODEM(1K), this protocol transfers data in 128 and 1024 bytes data blocks but in its 
first block it sends the filename, filesize and the file creation date. This protocol is fast, reliable 
and has a batch transfer capability.

YMODEM(BATCH -g )
Like XMODEM(1K), this protocol transfers data in 128 and 1024 bytes data blocks but in its 
first block it sends the filename, filesize and the file creation date. This protocol does not have 
intermediate acks and naks. Therefore it is more suited for the hardwired connection. This 
protocol is extremely fast but not recommended because a single error would cause the 
retransmission of the entire file. This protocol has a batch transfer capability.

ZMODEM
This is perhaps the most popular protocol today. It is fast because in can do full streaming, very 
reliable and allows batch file transfers. Also it allows the transfer of partial files (known as crash 
recovery) in case    transfer was aborted. 

KERMIT
This protocol was developed at Columbia University and is available for almost any operating 
system. This protocol would work over any communication channel as long it
is capable of receiving and sending printable ASCII characters. The maximum size of a packet in



the original kermit is limited to 94 bytes. But with the extended packet option, this size has been 
extended to 9024 bytes. WinTel supports extended packet size option. 

Related topics:

Receiving Files
Sending Files



Receiving Files

If    you want to receive files using ASCII, XMODEM or YMODEM Batch protocol. You choose 
receive command from the File transfer menu. This must be done after the remote system has 
informed you that it is ready to send you the files. Once you have selected the receive command, 
you will be asked for a filename of the downloaded file in case of ASCII and XMODEM (All 
flavors) protocol.

If you have opted for YMODEM batch or KERMIT protocol, no such dialog box appears as the 
filename is contained in first block of the data packet.

For ZMODEM, do not choose receive file command from the menu.This program will 
automatically detect the transfer once the downloading starts.

Once the file transfer starts, you will see a window with the statistics such as file name, total 
number of bytes to receive, number of bytes received etc. You may abort the transfer anytime by 
clicking on the Cancel button.



Sending Files

First you inform the remote system that you wish to upload files.As for the receiving files, you 
select the protocol which matches with the remote system. If you need to send multiple files 
choose YMODEM Batch, ZMODEM or KERMIT protocol. A dialog box would appear asking 
you for the name of files which you wish to transfer. For batch operations you may review the 
file list to be uploaded and make more additions or deletions. Once you are done, click on the 
done button. Another window would appear which shows you the file transfer statistics. If    you 
wish to abort the transfer then simply click on the Cancel button. Once your transfer is complete,
you will see a message to this effect in the transfer window. Click on the OK button to remove 
the transfer window from the screen. 



Utilities

Following utilities/options are available:

Viewing GIF/JPEG File
uuencode
uudecode
Unix/DOS Text Conversion



Viewing GIF/JPEG File
 
If you want to view a GIF/JPEG file while downloading it, enable the view GIF/JPEG realtime 
option from the utilities menu. Any file of type GIF/JPEG would be displayed on a separate 
window while being downloaded. 

You can also view stored GIF/JPEG files by selecting view GIF/JPEG offline command from the
utilities menu or from the toolbar. This would activate a WinGif task. By choosing "Open" from 
the file menu in WinGif and selecting file of type GIF/JPEG, the file can be viewed.    You can 
resize the picture by selecting stretch/shrink command in the File menu. You exit the GIF/JPEG 
viewer by choosing "Exit" command from the file menu.



UUENCODE

uuencode utility allows you to encode a binary file to an ASCII file so that it can be transmitted 
on Usenet or send as an email on an internet. When you select this option either from the utilities
menu or from the toolbar, You will be asked for the file name to encode. Select the file and your 
file be encoded with the extension uue. If your input file is of large size then the output file is 
split over into multiple files with sequence numbers appended to the file name. The first line of    
encoded file contains begin 600 filename and the last line has an end. 



UUDECODE
 
uudecode utility allows you to decode uuencoded file. Generally on an internet, a uuencoded file 
is transmitted in a batch because of its large size i.e. file a.uue may be transmitted as a1.uue and 
a2.uue. You select this option either from the utilities menu or from the toolbar . You would then 
be asked for the file names which need to be uudecoded. Once you have selected your files, press
on the done button and your file will be decoded. Make sure that each of the files contain a begin
at the start of the decoded text and an end at the end of the decoded text.



Unix-DOS and DOS-Unix Text Conversion
Unix to DOS Text File Conversion

This command is executed when you select Unix-to-DOS convert command in the utilities menu.
With this utility you can convert a text file downloaded from an Unix machine to the MS-DOS 
format. This utility essentially changes the Unix newline character NL (ASCII 10) to CR (ASCII 
13) and LF (ASCII 10). The DOS file is created with a .DOS extension. This operation can be 
performed in batch mode.

DOS to Unix Text File Conversion

This command is executed when you select DOS-to-Unix convert command in the utilities menu.
With this utility you can convert a text file in the MS-DOS format to Unix format This utility 
essentially changes the CR (ASCII 13) and LF (ASCII 10) characters to single Unix newline 
character i.e. NL (ASCII 10). The Unix file is named with an .UNX extension. This operation 
can be performed in batch mode.





Edit

Following commands are available:

Copy and Paste
Clearing Scroll Buffer



Copy and Paste

If you want to send the text from the clipboard, first copy the text to the clipboard. This can be 
done either from some other application or from your own screen. You select the text to be 
copied to the clipboard by pressing on the left mouse button and dragging over the text you want 
copied. Once the text is selected, choose copy command from the edit menu. Your text will be 
copied to the clipboard. Next choose the transmit command from the edit menu. Your text will be
transmitted. 



Clearing Scroll Buffer

When you receive text from the remote computer, this text is placed in a buffer which can be 
viewed by using vertical scroll bar. If you want to clear this buffer, use the clear buffer command
from the Edit menu.



Printing

You can print your session log file by selecting print logfile command from the File menu. You 
will be asked for the file name to be printed. Select the desired file and your file would be 
printed. You can also print the saved scroll back    buffer by selecting print buffer command from 
the File menu.

Related topic:

Session Capture



Session Capture

Select session capture command from the session menu. You can direct all your incoming data 
from the remote system onto to a file for later viewing and printing. Your session log file name 
would be the name of the online service you are    connected to with log extension. You can stop 
capturing the session by reselecting the capture session command from the session menu.

Related topic:

Printing



Disconnecting

If you want to disconnect from a session, select disconnect command from the session menu or 
the toolbar disconnect button. You may then either exit from the program or telnet to another 
service. You exit the program by selecting Exit command from the File menu or exit button in 
the toolbar.



Miscellaneous Commands
Switch to MS-DOS



Arrow and Keypad Key Dialog Box

This dialog box is invoked from the keyboard dialog box. The dialog box displays the arrow and 
keypad sequence sent to remote in application mode ( this mode is set by the host) when you 
press any of these keys. The codes sent depend on the type of terminal emulation you have 
chosen. With the num lock key down, the codes sent by keys 9 thru . are same as those of DECs 
VT100 and VT 52 terminals. If you have chosen VT100 as your terminal emulation then page 
up/down key take you 1 page forward/backward while using DECs EDT and home/end key take 
you to the top/bottom of a file.



Batchlist Dialog Box
Batch list dialog box is invoked when you want to upload file using ZMODEM or YMODEM 
protocols. It is also invoked when you want to uudecode internet files. Following buttons are 
available:
Done
You click on this button when you are done with creating a batchlist and ready to execute
previous command.
Delete
You click on this button to delete an entry from the batchlist.
Add
Add button is clicked when you want to add a file entry to the batchlist.



ASCII File Transfer Dialog Box
This dialog box is invoked from the protocol dialog box. Most systems require you to send a 
character to initiate the file transfer. This usually is a "return". Type in ^M if the remote system 
requests you to send a carriage return for downloading ASCII file. Some systems send a control 
character as an end of file transfer. This usually is control T. Type in ^T in the EOF character edit
box. 
There are three items in this dialog box:

Summary of ASCII transfer dialog box controls:
Strip Linefeed when Sending 
In a MS-DOS text file, a line is terminated by a carriage return (ASCII 13) and a line feed 
(ASCII 10). You enable this option if the remote system requires you to strip away the line feed.
Character to Initiate transfer
Remote system may require you to send a character to initiate ASCII file transfer. This usually is 
a carriage return. Enter that character in the edit box here.
Character to end file transfer
This is the character which remote computer sends to indicate the end of file transfer. You type in
this character in the edit box.
Inter-line delay
Here you specify the delay in milliseconds after each transfer of a line of text. The default is no 
delay.
Inter-character delay
Here you specify the delay in milliseconds for each transfer of a character. The default is no 
delay.



ZMODEM option dialog box
This dialog box is invoked from the protocol dialog box. There are three check buttons in this 
dialog box. They are:
Send skip if file exists
If you are downloading a file and this file already exists in your directory and it is of the same 
size then the system would inform the remote to skip sending this file if this option is enabled. A 
check mark would appear when this option is enabled.
Crash recover
If you are downloading a file and this file already exists in your directory and the size of the file 
is smaller, then the system would inform the remote of sending the file starting from the current 
size of the file.
Segmented streaming
This option enables segmented streaming i.e. there are intermediate acknowledgments. This 
would slow down the file transfer. This option however is useful if you are storing your data onto
a floppy.
Escape control
This option enables all control characters to be escaped. This is useful if the network you are 
connected to does not pass control characters. For example, if you are telnetting to another unix 
machine and the mode of connection is ASCII, then by enabling this option, you would be able 
to do file transfer directly to your machine



Switch to MS-DOS
When you select switch to MS-DOS command from the misc. menu, you would switch to MS-
DOS. You switch back to this program by typing EXIT at the MS-DOS prompt.    



Definition of function keys
You invoke this dialog box from the keyboard dialog box.You make an assignment to the 
function key by typing in the string in the edit box. Remember to type Enter key as ^M. 
Similarly all control keys are prefixed by a caret ^. For example if you want to define key F5 as 
control-Z then you would enter ^Z in the edit box. If you want the definition to contain an escape
character (ASCII 27) then you would enter ^[. 



Keycode dialog box
This dialog box appears when you click a key on a keyboard. It shows you ASCII code and its 
ASCII value. You can also view shifted, alt and control key codes by enabling    their check 
boxes. 

 



KERMIT options
This dialog box appears when you click on the options button in the protocol dialog box and you 
have selected KERMIT protocol in the listbox. For the block check option, WinTel supports 
block check type 1 and 2.
Following are the options available:
Maximum buffer size
Here you specify maximum possible packet size for KERMIT. The maximum size allowed is 
9024 bytes. However, your remote computer must be capable of sending and receiving packet of 
this size. The bigger the packet size, faster would be the file transfer.
It is recommended that you use 1024 bytes as the packet size.
Eight bit prefixing
Enable this option if    your communication channel is 7 bit wide.



Telnet Client to Remote Host using TCP/IP (SLIP/PPP)

You can connect to internet using Telnet. This allows your computer to talk to the remotehost 
using TCP/IP protocol. Before you can telnet to your host computer, you would require a TCP/IP
stack and if you are using your modem to dailin to your remote computer, you would need an 
internet dialer talking SLIP/PPP protocol. Windows 95 already has a built in TCP/IP stack and an
internet dialer. Once you have established a connection to internet using Windows 95 dialup 
networking, you are ready to telnet to the remote host. 

Double click on the Telnet icon in WinTel program group. A telnetbook would open up. You can 
create entries to the telnetbook by clicking on the new button. A communication dialog box 
would appear. You type in the telnetbook entry name in the name field and in the address field 
you type in the internet address of the remote host. If for example, you wish to telnet to 
CompuServe, then the name field, you would enter Compuserve and in the address field, 
compuserve.com.
Once an entry has been made, you can click on the connect button in the telnetbook dialog box. 
This program would then attempt to connect. Make sure your SLIP/PPP connection has already 
been established. 
When you have established your connection, you can do file transfer using xmodem, ymodem, 
zmodem and kermit. If you are transferring files, make sure you check the binary checkbox in 
the communication setting dialog box for xmodem and ymodem protocols. If you are using 
zmodem as your file transfer protocol, you must select escape control option in the zmodem 
options dialog box.
The advantages of using telnet over serial line connection is that you can have several sessions 
open at the same time. That is    different windows can communicate with different hosts at the 
same time. 



Telnetbook

You open telnetbook either from the toolbaror by selecting telnetbook command in the File 
menu. A list of all    internet entries would be shown in the listbox. Here is a summary of all the 
buttons in the telnetbook:

Cancel
Removes the telnetbook from the display.
Connect
Connects to the selected internet site
New
Adds a new internet site in the telnetbook.
Delete
Deletes a selected entry from the telnetbook.
Copy
Copies an existing entry to a new entry with a new name and a new internet address 



Copy internet telnetbook entry to a new entry
This dialog box is invoked from the copy button of the telnetbook settings dialog box. Once you 
have created an entry in the telnetbook, you can copy all the settings to a new entry. Following 
controls are provided:
Service name
Here you type in your new service name. Note that the maximum number of characters allowed 
is 8.
Internet Address
Here you specify a new internet site address. 



Telnet Communication Setting
 
Telnet Communication settings dialog box can be invoked from the telnetbook's edit button. This
command allows you to define your communication parameters. Here is a list of options 
available to you:

Cancel
Removes the box from display
Name
Enter the name of the internet host.
Address
Enter your host internet address.
Binary
Make sure this checkbox is checked when transferring files.
Port
Here you specify the protocol port number on the host to connect to. You can let the system 
decide the port for you by leaving this field as blank.



How to Register
WinTel32 1.02 Registration

NOTE: If you are registering through CompuServe , then at the GO prompt type SWREG and    
follow their instructions for registration. The CompuServe registration ID is #8757 

For all others, please fill out this order form:

Item Price

WinTel32 1.02 Disk ( 3.5 ___ or    5.25 ___) 
with manual $39.95
Shipping and Handling $ 5.0
Tennessee residents, please add 8.25 % sales tax $ 3.25
________________________________________________________________

Total Amount _______
________________________________________________________________

Name ____________________________________________________

Address 1 ____________________________________________________

Address 2 ____________________________________________________

City ______________________          State________      ZIP___________

Country ____________________________________________________

Phone ( ) ____________- ________________________________

Signature: ____________________

Online service where you downloaded WinTel32 from: _______________________

Please mail this form with your Check/Money Order (payable to Satyavrat Mehrotra):

Satyavrat Mehrotra
SMSOFT
1345 Oak Ridge Turnpike, Suite # 287
Oak Ridge, TN 37830

Please allow 2 - 3 weeks for delivery.






